
Network Interface Board
Type 1018 (option)

Quick Configuration Guide

Read this manual carefully before you use this product and keep it handy for future

reference.

For safety, please follow the instructions in this manual.



Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get

maximum versatility from this machine all operators should carefully read and follow the instructions in

this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related

to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable

for direct, indirect, special, incidental, or consequential damages as a result of handling or operating

the machine.

Trademarks

NetWare is a registered trademark of Novell, Incorporated. 

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Macintosh is a registered trademark of Apple Computer, Inc.

All other products referenced are trademarks or registered trademarks of their respective companies.

Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights in those marks.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual

might result in hazardous radiation exposure.

Notes:

Some illustrations might be slightly different from your machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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How to Read this Manual

Symbols

In this manual, the following symbols are used:

Important

If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference

This symbol indicates a reference.

[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's operation panel.

Keys on the computer's keyboard.
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Manuals for This Machine

Manuals for This Machine

There are ten manuals that separately describe the operational procedures for
the operation and maintenance of the machine.

To enhance safe and efficient operation of the machine, all users should read and
follow the instructions contained in the following manuals.

❖❖❖❖ Copy Reference
Describes the procedures and functions for using this machine as a copies.

❖❖❖❖ System Settings
Describes the system settings of this machine.

❖❖❖❖ Facsimile Reference <Basic Features>
Describes the procedures and most frequently functions for using this ma-
chine as a facsimile.

❖❖❖❖ Facsimile Reference <Advanced Features>
Describes the procedures and more advanced functions for using this ma-
chine as a facsimile. And also explains settings for key operators.

❖❖❖❖ Printer Reference 1
Describes the procedures and functions for using this machine as a printer.

❖❖❖❖ Printer Reference 2
Describes the procedures and provides necessary information about using
the printer and its options. This manual is included as a PDF file on the CD-
ROM labeled “Operating Instructions for Printer”.

❖❖❖❖ Network Interface Board Quick Configuration Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. This manual is in-
cluded as a PDF file on the CD-ROM labeled “Operating Instructions for
Printer”. (this manual)

❖❖❖❖ Type 1018 PostScript level2 Compatible Kit Operating Instructions Supplement
Describes the functions of Printer Utility for Mac. This manual is included as
a PDF file on the CD-ROM labeled “Operating Instructions for Printer”.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the printer in a UNIX envi-
ronment. This manual is included as a PDF file on the CD-ROM labeled “Op-
erating Instructions for Printer”.

❖❖❖❖ Network Interface Board Type 1018 Owner's Manual
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. This manual is in-
cluded as a PDF file on the CD-ROM labeled “Print Server Software and Doc-
umentation” which comes with Network Interface Board Type 1018.
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1. Getting Ready for Software
Installation

Support programs for the installation and configuration of the Network Inter-
face Board are included on two CD-ROMs. One is “Printer Drivers and Utilities”
and the other is “Print Server Software and Documentation” which come with
this machine.

You can select any of the programs listed in the Configuration Programs.

Configuration Programs

The CD-ROM labeled "Printer Drivers and Utilities" includes the following util-
ities.

❖❖❖❖ SmartNetMonitor for Admin
SmartNetMonitor for Admin is software that uses the TCP/IP and IPX/SPX
protocols to monitor the printers in a network. It can monitor multiple net-
work printers having IP addresses. We recommend network administrators
to use this software.

Reference

For more information about SmartNetMonitor for Admin, see the Smart-
NetMonitor for Admin Help file.

❖❖❖❖ SmartNetMonitor for Client
SmartNetMonitor for Client is software equipped with the following func-
tions. We recommend all users of this printer to install this software.

• Provides the function to print in a Peer-to-Peer network.

• Uses the TCP/IP and IPX/SPX protocols to monitor the status of devices
in a network constantly.

Reference

For more information about SmartNetMonitor for Client, see the Smart-
NetMonitor for Client Help file.

The CD-ROM labeled "Print Server Software and Documentation" includes the
following utilities.

❖❖❖❖ MAP
Web-based configuration utility

❖❖❖❖ IPX Peer-to-Peer
IPX Peer-to-Peer printing software

❖❖❖❖ IP Peer-to-Peer
IP Peer-to-Peer printing software

❖❖❖❖ NWSetup
NetWare Print Service Configuration
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The four utilities are included on the “Print Server Software and Documenta-
tion” CD-ROM, but you need this CD-ROM only if you use ”IPX Peer-to-Peer”
or “IP Peer-to-Peer” printing.

Although you can use the "MAP" or "NWSetup" utilities on the "Print Server
Software and Documentation" CD-ROM, it is easier to use the SmartNetMono-
tor for Admin/Client included on the "Printer Drivers and Utilities" CD-ROM.

To use “MAP” or “NWSetup” from the “Print Server Software and Documenta-
tion” CD-ROM, see the “Owner's Manual”on the CD-ROM labeled “Print Server
Software and Documentation” for instructions.
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SmartNetMonitor for Admin/Client

Utilities called SmartNetMonitor for Admin and SmartNetMonitor for Client are
provided to configure the printer to work in a network environment.

Limitation

❒ SmartNetMonitor for Admin/Client are supported to work with the follow-
ing operating systems.

• Microsoft Windows 95 *1 /98 *2 /Me *3 

• Microsoft Windows 2000 *4 

• Microsoft Windows NT 4.0 *5 

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Millennium Edition
*4 Microsoft Windows 2000 Professional

Microsoft Windows 2000 Server
*5 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT

Workstation operating system version 4.0 in a computer using x86 processors.

❖❖❖❖ SmartNetMonitor for Admin
SmartNetMonitor for Admin is software that uses the TCP/IP and IPX/SPX
protocols to monitor the printers in a network. It can monitor multiple net-
work printers having IP addresses. We recommend network administrators
to use this software.

❖❖❖❖ SmartNetMonitor for Client
SmartNetMonitor for Client is software equipped with the following func-
tions. We recommend all users of this printer to install this software.

• Provides the function to print in a Peer-to-Peer network.

• Uses the TCP/IP and IPX/SPX protocols to monitor the status of devices
in a network constantly.

Installing SmartNetMonitor for Admin

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Note

❒ Auto Run might not automatically work with certain OS settings. In this
case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select "Custom" installation and then click [Next].
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E Remove the check mark from the [Printer Driver].

F Click to select [Utility] and then click [Detail].

G Click to select [SmartNetMonitor for Admin] and then click [OK].

H Click [OK].

I Follow the instructions on the screen.

After installation is completed, see P.34 “Setting Up as a Print Server” when
you use the printer as a print server.

Note

❒ If you require restarting the computer after installation of SmartNetMoni-
tor for Admin was completed, restart the computer and continue to config-
uration.

Installing SmartNetMonitor for Client

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Note

❒ Auto Run might not automatically work with certain OS settings. In this
case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select "Custom" installation, and then click [Next].

E Remove the check mark from the [Printer Driver].

F Click to select [SmartNetMonitor for Client], and then click [OK].

G Click [OK].

H Follow the instructions on the screen.

Note

❒ If you are required to restart the computer after the installation of Smart-
NetMonitor for Client, restart the computer and continue with necessary
configurations.
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2. Windows 95/98/Me
Configuration

Windows 95/98/Me Configuration

This section describes how to configure the Peer-to-peer printing. The Peer-to-
peer printing software that is included on the CD-ROM labeled ”Printer Drivers
and Utilities”. “Print Server Software and Documentation” allows Windows 95/
98/Me PCs to communicate directly with network attached printers. A network
server, such as NetWare or Windows NT, is not required for Peer-to-peer print-
ing.

There are three types of Peer-to-peer printing. You can select ”SmartNetMonitor
for Admin/Client”, “IP Peer-to-Peer” and “IPX Peer-to-Peer” according to your
network environment.

The Peer-to-peer printing software must be installed on each PC that uses Peer-
to-peer printing. Once Peer-to-peer printing software is installed, all Network
Interface Boards on the network automatically appear in the list of available
printer ports.

The Peer-to-peer printing software can also be used in networks where servers
are present; however, server based print services are often utilized instead. Serv-
er based print services offer centralized printing management and spooling and
do not require software (other than the printer driver) to be installed on each PC.

If you use the printer in a network where servers are present, select either Peer-
to-peer printing or the server based print service.

Reference

For more information about setting IP parameters, see “Configuring the Printer
for the Network with the Operation Panel” in “Printer Reference 1”.
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Using SmartNetMonitor for Client

Preparation

To use SmartNetMonitor for Client, you must install it as [Network] installa-
tion and use TCP/IP or IPP protocol in a Peer-to-Peer Network.

Installing SmartNetMonitor for Client

Preparation

Select [Network] installation when you print without using a print server.

[Network] installation installs the PCL 5e and PCL 6 printer driver and Smart-
NetMonitor for Client. When you print using TCP/IP or IPP protocol in a
Peer-to-Peer Network, you must select this installation.

[Custom] installation allows you to install SmartNetMonitor for Client sepa-
rately.

Installing by "Network" installation

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Important

❒ Never have two versions of the same printer driver installed on your sys-
tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this
case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Network] installation when the selection screen appears.

E Follow the instructions on the screen.

F Select a printer you want to use when the [Select Printer] dialog box appears.

G Click [Add..] when the [Select Port] dialog box appears.

H Select [SmartNetMonitor for Client], and then click [OK].

Available printers will be listed.



Using SmartNetMonitor for Client

7

2

I Select a printer you want to use.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used. 

IPP

A Click [IPP].

The IPP setting dialog box appears.

B In [Printer URL], type “http://IP address:631/Print” as the printer's IP ad-
dress.

(Example IP address is 192.168.15.16)

http://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

J Click [OK].

K Confirm that the selected port is highlighted, and then click [Next].

L Click [Finish].

M Restart the computer after the installation is complete.

N Set up the options with the printer driver.

Reference

For more information about settings for options, see “Installing the Printer
Driver and Software” in “Printer Reference 1”.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to change the
settings of SmartNetMonitor for Client.

Reference

For more information about these settings, see SmartNetMonitor for Client
Help.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

B Click to select the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Details] tab, and then click [Port Settings]. 

The SmartNetMonitor for Client settings dialog box appears.
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Using IP Peer-to-Peer

Important

❒ The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that
the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

Important

❒ Confirm that the printer power is turned on before starting the following pro-
cedure.

A  Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”. 

B Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

C Click [Install/Configuration Utilities].

The “Installation/Configuration Utilities” page appears.

D Click [Windows IP Peer-to-Peer Printing].

The “Windows IP Peer-to-Peer Printing” page appears. 

This page describes the functions of this utility. 

E At the bottom of the page, click the blue word [Install IP-P2P...] to begin in-
stalling.

F The [Welcome] dialog box appears.

G Click [Next].

The [Installation Notes] dialog box appears. 

H Click [Yes].

The [Choose Destination Directory] dialog box appears. 

I Click [Browse] to set a different folder. 

The default installation folder is C:\PROGRAM FILES\IP-P2P. 
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J Click [Next].

The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

K Type the name that you wish to see in “Program Folder:” and click [Next].

The files are then copied to the computer in the specified directories.

L Follow the instructions on the screen.

M Click [OK] to complete the installation.

Reference

For more information about installing IP Peer-to-Peer, see the “Owner's
Manual” on the CD-ROM labeled “Print Server Software and Documenta-
tions”.

----For manual installation

Follow these steps to install the software on your operating system (Windows
95/98/Me).

A Insert the CD-ROM into the CD-ROM drive.

B Close all the applications that are currently running.

C Click [Start] on the task bar, and click [Run]. 

D Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

E Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to G- L in the preceding procedure. ⇒ P.9 “In-
stalling IP Peer-to-Peer”
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Selecting the Printer Port

The Peer-to-peer printing software should be installed on each Windows 95/98/
Me PC that will use Peer-to-peer printing services.

A Install the printer driver you want to use.

If the printer drivers have already been installed, you can go to the next step.

Reference

For more information about the printer drivers, see “Installing the PCL 6/5e
Printer Driver” or “Installing the PostScript Printer Driver” in “Printer Refer-
ence 1”.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers]. 

The [Printers] window appears.

C Click the icon of the printer you want to set for Peer-to-peer printing.

D On the [File] menu, click [Properties].

The Printer Properties appear.

E Click the [Details] tab.

F From the [Print to the following port:] list box, select the port of the printer you
want to use for Peer-to-peer printing.

• Select the IP address of the printer. If you do not find the IP address of the
printer, the printer is not in your local subnet. Then you need to configure
IP Peer-to-Peer port manually as described in the “Owner's Manual” on
the CD-ROM labeled “Print Drivers and Utilities”.

G Click [OK].

Deleting the Port

The following procedure allows you to delete the printer port. If you want to delete the
port which is currently used in Windows, switch the port to another such as "FILE",
then delete it. For more information about IP Peer-to-Peer, see the “Owner's Manual”.

A Click [Start] on the taskbar, point to [Programs], and then click [IP-P2P]. 

The [IP-Peer to Peer Setup] window appears.

B Click [Printers...].

C Click [Find Printers].

Available printers appear.

D Click to select the port you want to delete from “Unit Name” list.

E Click [Delete].
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Using IPX Peer-to-Peer

Important

❒ The IPX protocol is required for IPX Peer-to-Peer printing. Confirm that the IPX
protocol is installed, if not, install it before starting the following procedure.

Note

❒ IPX protocol can use with Windows 95/98/Me.

Installing IPX Peer-to-Peer

Follow these steps to install IPX Peer-to-Peer.

A Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

Note

❒ If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader
4.0].

B Click [CD ROM Contents].

The “Introduction” page appears.

C Click [Installation/Configuration Programs].

The “Configuration Programs” page appears.

D Click [Windows 95/98/Me & NT 4.x IPX Peer-to-Peer Printing].

The “Windows 95/98/Me and NT 4.x IPX Peer-to-Peer Printing” page ap-
pears. 

This page describes the functions of this utility. 

E At the bottom of the page, click the blue word [here] to begin installing.

A dialog box appears asking if the “Setup.exe” program should be started.

F Click [Yes].

The [Welcome] dialog box appears.

G Click [Next].

The [Installation Notes] dialog box appears.

H Click [Yes].

The files are then copied to the computer in the specified directories.

The [Installation Complete] dialog box appears. 

I Click [Finish] to complete the installation.
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----For manual installation

Follow these steps to install the software on your operating system (Windows
95/98/Me).

A Insert the CD-ROM into the CD-ROM drive.

B Close all the applications that are currently running.

C Click [Start] on the taskbar, and click [Run]. 

D Type <Drive>:\IPX-P2P\SETUP.EXE (where <Drive> is your CD-ROM
drive name).

E Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to G - I in the preceding procedure. ⇒ P.12 “In-
stalling IPX Peer-to-Peer”

Selecting the Printer Port

The Peer-to-peer printing software should be installed on each Windows 95/98/
Me PC that will use Peer-to-peer printing services.

A Install the printer driver you want to use.

If the printer drivers have already been installed, you can go to the next step.

Important

❒ Using IPX Peer-to-Peer printing, confirm that the printer power is turned
on before continuing the following steps.

Reference

For more information about the printer drivers, see “Installing the PCL 6/5e
Printer Driver” or “Installing the PostScript Printer Driver” in “Printer Refer-
ence 1”.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers]. 

The [Printers] window appears.

C Click the icon of the printer you want to set for the Peer-to-peer printing.

D On the [File] menu, click [Properties].

The Printer Properties appear.

E Click the [Details] tab.
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F From the [Print to the following port:] list box, select the port of the printer you
want to use for Peer-to-peer printing.

• Select the printer name. The printer name is shown in "Peer-to-Peer Con-
nection Information" on the network configuration page. The default set-
ting of the printer name is “RDP_” followed by the 6 digit serial number.

G Click [OK].
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3. Windows 2000
Configuration

Windows 2000 Configuration

This manual describes the procedures and provides necessary information
about setting up and using the printer under the network environment using
Windows 2000. 

• If a NetWare server is present, NetWare print services might be used by fol-
lowing the NetWare Configuration instructions in this guide.
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Using SmartNetMonitor for Client

Preparation

To use SmartNetMonitor for Client, you must install it as [Network] installa-
tion and use TCP/IP or IPP protocol in a Peer-to-Peer Network.

Installing SmartNetMonitor for Client

Preparation

Select [Network] installation when you print without using a print server.

[Network] installation installs the PCL 5e and PCL 6 printer driver and Smart-
NetMonitor for Client. When you print using TCP/IP or IPP protocol in a
Peer-to-Peer Network, you must select this installation.

[Custom] installation allows you to install SmartNetMonitor for Client sepa-
rately.

Installing by "Network" installation

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Important

❒ Never have two versions of the same printer driver installed on your sys-
tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this
case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Network] installation when the selection screen appears.

E Follow the instructions on the screen.

F Select a printer you want to use when the [Select Printer] dialog box appears.

G Click [Add..] when the [Select Port] dialog box appears.

H Select [SmartNetMonitor for Client], and then click [OK].

Available printers will be listed.
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I Select a printer you want to use.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used. 

IPP

A Click [IPP].

The IPP setting dialog box appears.

B In [Printer URL], type “http://(printer's IP address)/printer” as the printer's
IP address.

(Example IP address is 192.168.15.16)

http://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

J Click [OK].

K Confirm that the selected port is highlighted, and then click [Next].

L Click [Finish].

Note

❒ During installation, the [Digital Signature Not Found] dialog box may appear.
In this case, click [Yes] to continue the installation.

M Restart the computer after the installation is complete.

N Set up the options with the printer driver.

Reference

For more information about settings for options, see “Installing the Printer
Driver and Software” in “Printer Reference 1”.

Note

❒ You can specify the "User Code" with the printer properties after installing
the printer driver. See the Help file for the printer driver.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to change the
settings of SmartNetMonitor for Client.

Reference

For more information about these settings, see SmartNetMonitor for Client
Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Details] tab, and then click [Port Settings]. 

The SmartNetMonitor for Client settings dialog box appears.
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Printing with a Standard TCP/IP Port

Preparation

Select [Typical] installation when you use the printer with Standard TCP/IP
port.

[Typical] installation installs the PCL 5c and RPCS printer driver.

Installing the Printer Driver

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Important

❒ Never have two versions of the same printer driver installed on your sys-
tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this
case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Typical] installation, and then click [Next].

E Follow the instructions on the screen.

F Select [Standard TCP/IP] when the "Select Port" dialog box appears, and then
click [Next].

G Click [Next] in the "Add Standard TCP/IP Printer Port Wizard" window.

H Type the printer name or IP address in the "Printer Name or IP Address"
box.

I Click [Finish] in the "Add Standard TCP/IP Printer Port Wizard" window.

J Confirm that the selected port has been displayed in the "Port" box, and
then click [Next].

Note

❒ During installation, the [Digital Signature Not Found] dialog box may appear.
In this case, click [Yes] to continue the installation.
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K Click [Finish].

Note

❒ You can specify the "User Code" with the printer properties after installing
the printer driver. See the Help file for the printer driver.

L Restart the computer after the installation is complete.

M Set up the options with the printer driver.

Reference

For more information about settings for options, see “Installing the Printer
Driver and Software” in “Printer Reference 1”.
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4. Windows NT 4.0
Configuration

Windows NT 4.0 Configuration

There are several options for setting up printing in a Windows NT environment.

• If a NetWare server is present, NetWare print services might be used by fol-
lowing the NetWare Configuration instructions in this guide.

• Peer-to-peer print services can be available by using “IP Peer-to-Peer”.

• LPR print services can be used via TCP/IP by following the instructions in
this section.

Windows NT printing is very flexible. It is possible to configure the individual
Windows NT or Windows 95/98/Me workstations to print using a different
protocol from the Windows NT server. For example, a Windows NT server
could be configured to print to the Network Interface Board via TCP/IP using
the instructions in this section. The Network Interface Board could then be des-
ignated as shared on the NT server, allowing workstations to print via the NT
server using a different protocol.

The optimum Windows NT printing configuration depends on the particular
environment and user as well as administrator experience and preferences. Gen-
erally, LPR printing over TCP/IP covered in the following instructions is the
best choice for environments where TCP/IP is already in use.
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Using the SmartNetMonitor for Client

Preparation

To use SmartNetMonitor for Client, you must install it as [Network] installa-
tion and use TCP/IP or IPP protocol in a Peer-to-Peer Network.

Installing the SmartNetMonitor for Client

Preparation

Select [Network] installation when you print without using a print server.

[Network] installation installs the PCL 5e and PCL 6 printer driver and Smart-
NetMonitor for Client. When you print using TCP/IP or IPP protocol in a
Peer-to-Peer Network, you must select this installation.

[Custom] installation allows you to install SmartNetMonitor for Client sepa-
rately.

Installing by "Network" installation

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Important

❒ Never have two versions of the same printer driver installed on your sys-
tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this
case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Network] installation when the selection screen appears.

E Follow the instructions on the screen.

F Select a printer you want to use when the [Select Printer] dialog box appears.

G Click [Add..] when the [Select Port] dialog box appears.

H Select [SmartNetMonitor for Client], and then click [OK].

Available printers will be listed.
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I Select a printer you want to use.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used. 

IPP

A Click [IPP].

The IPP settings dialog box appears.

B In [Printer URL], type “http://(printer's IP address)/printer” as the printer's
IP address.

(Example IP address is 192.168.15.16)

http://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

J Click [OK].

K Confirm that the selected port is highlighted, and then click [Next].

L Click [Finish].

M Restart the computer after the installation is complete.

N Set up the options with the printer driver.

Reference

For more information about settings for options, see“Installing the Printer
Driver and Software” in “Printer Reference 1”.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to change the
settings of SmartNetMonitor for Client.

Reference

For more information about these settings, see SmartNetMonitor for Client
Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Details] tab and click [Port Settings]. 

The SmartNetMonitor for Client settings dialog box appears.
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Using IP Peer-to-Peer

Important

❒ The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that
the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

Important

❒ Confirm that the printer power is turned on before starting the following pro-
cedure.

A  Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”. 

B Insert the CD-ROM labeled“Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

C Click [Install/Configuration Utilities].

The “Installation/Configuration Utilities” page appears.

D Click [Windows IP Peer-to-Peer Printing].

The “Windows IP Peer-to-Peer Printing” page appears. 

This screen describes the functions of this utility. 

E At the bottom of the page, click the blue word [Install IP-P2P...] to begin in-
stalling.

F The [Welcome] dialog box appears.

G Click [Next].

The [Installation Notes] dialog box appears. 

H Click [Yes].

The [Choose Destination Directory] dialog box appears.

I Click [Browse] to set a different folder.

The default installation folder is C:\PROGRAM FILES\IP-P2Puy
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J Click [Next].

The [Select Program Folder] dialog box appears.

This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

K Type the name that you want to see in the Program Folder and click [Next].

The files are then copied to the computer in the specified directories.

L Follow the instructions on the screen.

M Click [OK] to complete the installation.

Reference

For more information about installing IP Peer-to-Peer, see the “Owner's
Manual” on the CD-ROM labeled “Print Server Software and Documenta-
tions”.

----For manual installation

Follow these steps to install the software on your operating system (Windows
NT 4.0).

A Insert the CD-ROM into the CD-ROM drive.

B Close all the applications that are currently running.

C Click [Start] on the taskbar, and click [Run]. 

D Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive
name).

E Click [OK].
The [Welcome] dialog box appears.

The remaining steps are identical to G- L in the preceding procedure. ⇒ P.25 “In-
stalling IP Peer-to-Peer” 
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Selecting the Printer Port

The IP Peer-to- Peer printing software should be installed on each Windows NT
4.0 PC that uses Peer-to-peer printing services.

Important

❒ The IP Peer-to-Peer printing software must be installed before selecting the
printer port.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
“Installing the PCL 6/5e Printer Driver” in “Printer Reference 1” to start the in-
stallation and then go to the next step.

C The [Printer Installation] dialog box appears.

D From the [Port] list, select the IP address of the printer you want to set up,
and click [Next >].

E Follow the instructions on the screen to finish the installation of the printer
driver.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about IP Peer-to-Peer, see the
“Owner's Manual”.

A Click [Start] on the taskbar, point to [Programs], and then click [IP-P2P].

The [IP-Peer to Peer Setup] window appears.

B Click [Printers...].

C Click [Find Printers].

Available printers appear.

D Click to select the port you want to delete from “Unit Name” list.

E Click [Delete].
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Setting Up LPR Printing

Follow these steps to set up LPR printing.

Note

❒ In the following instructions, some fields or dialog box names may differ de-
pending on the NT service pack in use.

A Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”. 

B Click [Start] on the taskbar, point to [Settings], and then click [Control Panel].

C Double-click [Network] and select the [Protocols] tab to confirm that the TCP/
IP protocol is installed.

If the TCP/IP protocol is not in the list of Network Protocols, click [Add] to in-
stall it.

D Select the [Services] tab.

If Microsoft TCP/IP Printing is not on the list of Network Services, click [Add]
to install it.

E Click [Close] when all protocols and services have been added.

If the TCP/IP protocol has just been added, set the IP address and other TCP/
IP parameters.

The new protocols and services will be available after the system is restarted.

Important

❒ If the printer driver has not been installed yet, install it before continuing.

F Click [Start] on the taskbar, point to [Settings], and then click [Printers].

G Right click the appropriate printer and select [Properties].

H On the [Ports] tab, click [Add Port].

I Double-click [LPR Port] in the list of available printer ports.

J In the [Name or address of server providing lpd:] field, type the IP address of the
Network Interface Board (that was assigned with the operation panel).

K In the [Name of printer or print queue on that server:] field, type “PORT1” (quo-
tation marks are not included) in capital letters and click [OK].
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L Click [Close] to close the [Printer Ports] dialog box.

The IP address of the Network Interface Board is now displayed and current-
ly selected on the list of ports.

M If the printer is to be shared, click the [Sharing] tab, select Shared and type
the Share name.

N Click [OK].
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5. Dynamic Host Configuration
Protocol (DHCP)

Dynamic Host Configuration Protocol 
(DHCP)

The Dynamic Host Configuration Protocol (DHCP) provides a mechanism for
delivering IP configuration parameters, including the IP address, subnet mask
and default gateway, to devices (hosts) on an IP network. A DHCP server man-
ages the pool of available IP addresses and grants device requests for an IP ad-
dress.

At power-up, the Network Interface Board broadcasts a DHCP request for an IP
address. If a DHCP server is present, the request might be processed, and an IP
address might be returned to the Network Interface Board. Upon receipt of the
IP address, the Network Interface Board resets, and prints a network configura-
tion page. The network configuration page might list the new IP address (and
Subnet mask and default gateway). Once an IP address has been assigned to the
Network Interface Board, it might no longer broadcast DHCP requests.

Important

❒ The IP address of the Network Interface Board assignment by DHCP works
only if the Network Interface Board does not have an existing IP address.

The DHCP server leases a temporary IP address which expires after a period of
time, or leases a permanent or unlimited lease which does not expire.

Devices that are granted a temporary lease are notified before the lease expires
and asked if they want to extend the lease. The Network Interface Board contin-
ues extending its lease indefinitely (unless prohibited by your DHCP server con-
figuration) and thus maintains a consistent IP address.

Important

❒ If the Network Interface Board is not turned on or is not connected to the net-
work during the period when the DHCP server is sending requests to extend
the lease, the lease will not be extended. The DHCP server might cancel the
lease and might assign the IP address to another device. Therefore, it is highly
recommended that you reserve an IP address for the Network Interface Board
in your DHCP server configuration.

If you do not to use DHCP for IP address assignment, it can be disabled using
the NIB Setup Tool. The NIB Setup Tool allows you to use a Wizard or a Prop-
erty Sheet to configure the Network Interface Board. Use the Property Sheet to
disable this feature. After you select the Network Interface Board with the NIB
Setup Tool, click [Configure] and then click the [TCP/IP] tab. If you do not to use
DHCP, select [Specify an IP Address] and set the IP address, the subnet mask and
the default gateway address.
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6. NetWare Configuration

This chapter describes how to configure the printer to use as a print server in a
NetWare environment.

❖❖❖❖ SmartNetMonitor for Admin
To use a printer in a NetWare environment, configure the NetWare printing
environment by using SmartNetMonitor for Admin.

Note

❒ If you configure NetWare printing environment by using SmartNetMoni-
tor for Admin under following environment, NetWare Client which is pro-
vided by Novell is required.

• NDS mode in Windows 95/98/Me

• NDS or Bindary mode in Windows 2000/Windows NT4.0

❖❖❖❖ Printers listed by SmartNetMonitor for Admin
SmartNetMonitor for Admin displays a list of printers, which are connected
to the network.
If you cannot find out the printer from the displayed list, refer to the config-
uration page printed from the printer. For more information about printing a
configuration page, see “Printing a configuration page” in "Printer Reference
1".

NetWare 3.x - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 3.x environment.

Note

❒ This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

Basic Procedure

Installing the NIB Setup Tool

Configuring Network Interface Board

Configuring NetWare

Turning the power off and on
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Setting Up as a Print Server

Follow these steps to set up the printer as a print server.

Preparation

Install the SmartNetMonitor for Admin first in accordance with the steps ex-
plained. See P.3 “Installing SmartNetMonitor for Admin”

A Log on to the file server as a Supervisor or a Supervisor equivalent.

B Run SmartNetMonitor for Admin.

C Click the [Group] menu and click [Open LAN] and select [IPX/SPX].

A list of printers appears

Note

❒ If you cannot identify which printer to configure from the list of printers,
print Configuration Page from the printer and find the desired printer. For
more information about printing Configuration Page, see “Printing a con-
figuration page” in "Printer Reference 1". 

D Click to select the printer you want to configure, and then click [NIB Setup
Tool] on the [Tools] menu.

E Click to select [Wizard], and then click [OK].

F Type the device name into the [Device Name] box and comment into the [Com-
ment] box as necessary, and then click [Next].

G Select the [NetWare] check box, and then click [Next].

H Click to select [Bindery], type the file server name into the [File Server Name:]
box, and then click [Next].

In the [File Server Name:] box, type the name of the file server in which a print
server is to be created. You can also select a file server from the list that ap-
pears by clicking [Browse].

I Type the print server name into the [Print Server Name] box, printer name into
the [Printer Name] box, and print queue name into the [Print Queue Name] box,
and then click [Next].

• In the [Print Server Name] box, type the name of the NetWare print server
within 47 characters.

• In the [Printer Name] box, type the name of the NetWare printer.

• In the [Print Queue Name] box, type the name of the print queue to be added
to NetWare.

J After confirming the settings, click [Next].

The settings take effect, and the NIB setup tool exits.
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K Exit SmartNetMonitor for Admin.

L Turn the printer power off and on.

Note

❒ To confirm that the printer is configured correctly, type as follows from the
command prompt.

F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
an attached user.
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NetWare 4.x, 5.x - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 4.x, 5.x environment.

❖❖❖❖ To use NetWare 5.x

• If you use Pure IP, use the printer as a print server. You cannot use the
printer as a remote printer when you use Pure IP.

• You cannot use the NDPS (Novell Distributed Print Services) mode.

Setting Up as a Print Server

Follow these steps to set up the printer as a print server.

Preparation

Install the SmartNetMonitor for Admin first in accordance with the steps ex-
plained. See P.3 “Installing SmartNetMonitor for Admin”

A Log on to the file server as a Supervisor or a Supervisor equivalent.

B Run SmartNetMonitor for Admin.

C Click the [Groupe] menu and click [Open LAN] and select [IPX/SPX] or [TCP/IP].

A list of printers appears

Note

❒ If you use Pure IP, select [TCP/IP].

❒ If you cannot identify which printer to configure from the list of printers,
print Configuration Page from the printer and find the desired printer. For
more information about printing Configuration Page, see “Printing a con-
figuration page” in "Printer Reference 1".

Basic Procedure

Installing the NIB Setup Tool

Configuring Network Interface Board

Configuring NetWare

Turning the power off and on
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D Click to select the printer you want to configure, and then click [NIB Setup
Tool] on the [Tools] menu.

Note

❒ If you use Pure IP, see P.38 “Using Pure IP in the NetWare 5.x environment”.

E Click to select [Wizard], and then click [OK].

F Type the device name into the [Device Name] box and comment into the [Com-
ment] box as necessary, and then click [Next].

G Select the [NetWare] check box, and then click [Next].

H Click to select [NDS], type the file server name into the [File Server Name:] box,
the NDS tree name into the [Tree:] box and the context into the [Context:]
box, and then click [Next].

In the [File Server Name:] box, type the name of the file server in which a print
server is to be created. You can also select a file server from the list that ap-
pears by clicking [Browse].

Clicking [Browse], you can select a NDS context among those listed in the
[Browse] dialog box.

As a context, object names are typed from a lower object and divided by a period.
For example, if you want to create a print server into NET under DS, type "NET.DS".

I Type the print server name into the [Print Server Name] box, printer name into
the [Printer Name] box, print queue name into the [Print Queue Name] box, and
print queue volume into the [Print Queue Volume], and then click [Next].

• In the [Print Server Name] box, type the name of the NetWare print server
within 47 characters.

• In the [Printer Name] box, type the name of the NetWare printer.

• In the [Print Queue Name] box, type the name of the print queue to be added
to NetWare.

• In the [Print Queue Volume], type the volume of print queue. As a volume,
object names are typed from a lower object and divided by a period. You
can select a volume by clicking [Browse].

J After confirming the settings, click [Next].

The settings take effect, and the NIB setup tool exits.

K Exit SmartNetMonitor for Admin.

L Turn the printer power off and on.

Note

❒ To confirm that the printer is configured correctly, type as follows from the
command prompt.

F:> NLIST USER /A/B

❒ If the printer works as configured, the name of the print server appears as
an attached user.



NetWare Configuration

38

6

Using Pure IP in the NetWare 5.x environment

A Log on to the file server as an Admin or an Admin equivalent.

B Run SmartNetMonitor for Admin.

C Click [Property Sheet] and click [OK].

The [NIB Setup Tool] dialog box appears.

D Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name:] box, type the name of the print server.

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

C In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse Context] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".

D In the [Print Server Operation Mode] group, click [As Print Server].

E Click [OK] to close the property sheet.

F After a confirmation dialog box appears, click [OK].

E Exit SmartNetMonitor for Admin.

After this step, go to step I on P.36 “Setting Up as a Print Server”.
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

After installing the printer driver, change the print port to NetWare queue.

Note

❒ This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setup procedure.

Windows 95/98/Me

Follow these steps to set up a Windows 95/98/Me client. 

Preparation

Log on to the NetWare file server before starting the following procedure.

A Install the printer driver you want to use as “Local printer”.

Reference

For more information about installing the printer driver, see“Installing the
PCL 6/5e Printer Driver” and “Installing the PostScript Printer Driver” in
“Printer Reference 1”.

Note

❒ Any port is selected during the installation, however, LPT1 is recommend-
ed.

B Click [Start], point to [Settings], and then click [Printers].

C In the [Printers] window, click the icon of the printer you want to use. 

D On the [File] menu, click [Properties].

E Click the [Details] tab, and click [Add Port].

F Click [Network] and click [Browse].

G On the network tree, double-click the name of the file server.

The queues appear.

H Click the queue you want to print, and click [OK].

I Click [OK].

In the [Print to the following port] box, a network path to the printer appears.

J Click [OK] to close the Printer Properties, and again, open it.
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K Click the [Printer Settings] tab.

L Clear the [Form feed] and [Enable banner] check boxes.

Note

❒ You should not select these check boxes because they should be specified
using the printer driver. If they are selected, the printer might not print
correctly.

When Using the PostScript Printer Driver

Follow these steps to set up for the PostScript Printer Driver.

A Click the [PostScript] tab. 

B Click [Advanced].

C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

M Click [OK] to close the Printer Properties.

Windows 2000

Follow these steps to set up a Windows 2000 client.

Preparation

Log on to the NetWare file server before starting the following procedure. To
use the NetWare server, select [Typical] installation.

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Important

❒ Never have two versions of the same printer driver installed on your sys-
tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this
case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Typical] installation, and then click [Next].

E Follow the instructions on the screen.



Setting Up a Client Computer

41

6

F Click [Add] when the "Select Port" dialog box appears.

G Select [network printer], and then click [OK].

H Double-click the computer name you want to use as a print server in the
"Browse for Printer" window.

I Select the printer you want to use, and then click [OK].

J After confirming that the pass indicates the selected printer has been dis-
played, click [Next].

K Follow the instructions on the screen.

L Restart the computer after installation is complete.

Note

❒ If the [Digital Signature Not Found] dialog box appears, click [Yes] to continue
the installation.

M Click [Start] on the task bar, point to [Settings], and then click [Printers].

The [Printers] window is displayed.

N Click to select the icon of the printer you want to use, and then click [Prop-
erties] on the [File] menu.

The printer driver's property is displayed.

Limitation

❒ Changing the printer settings requires Manage Printers permission. Mem-
bers of the Administrators and Power Users groups have Manage Printers
permission by default. When you set up options, log on using an account
that has Manage Printers permission.

O Click the [NetWare Settings] tab.

P Click to clear the [Form feed] and [Enable banner] check boxes, and then click
[OK].

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.

A Click the [PostScript] tab.

B Click [Advanced].

C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

Q Click [OK] to close the [Printer properties] dialog box.
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being
installed, the warning dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that
was used in installing the driver that is displayed in the message, and reinstall
with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.
If the printer driver disk is a CD-ROM, the sources of installation are as fol-
lows. If the installer starts up, click [Cancel] to quit it.
• PCL 5e

DRIVERS\PCL5C\WIN2000\(Language)\DISK1

• PCL 6
DRIVERS\PCL6\WIN2000\(Language)\DISK1

• PostScript
DRIVERS\PS\WIN2000\(Language)

Windows NT 4.0

Follow these steps to set up a Windows 2000/Windows NT 4.0 client.

Preparation

Log on to the NetWare file server before starting the following procedure.

A Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.

B Click [No].

C Close all the applications that are currently running.

D Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
“Installing the PCL 6/5e Printer Driver” and “Installing the PostScript Printer
Driver” in “Printer Reference 1” to start the installation and then go to the next
step.

E The [Printer Installation] dialog box appears.

F From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

G Follow the instructions on the screen to finish the installation of the printer
driver.
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7. Macintosh Configuration

Configuring Macintosh

This section describes how to configure a Macintosh to use EtherTalk. The actual
procedures to configure a Macintosh may differ depending on the version of the
Mac OS. The following procedure describes how to configure Mac OS 8. If you
are not using Mac OS 8, see the manual that comes with your version of the Mac
OS for more information.

Limitation

❒ For use with Macintosh OS 8 or 9.

Changing to EtherTalk

Follow the procedure to configure a Macintosh to use EtherTalk.

Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

A Open [Control Panel], and then double-click the [AppleTalk] icon.

B From the [Connect via:] pop-up menu, select "Ethernet".

C If you change zones, select a name from the [Current zone:] pop-up menu.

D Close the [AppleTalk] control panels.

E Restart the computer.

Change to EtherTalk

Basic Procedure

Configure the printer

Change the printer name

Change the zone
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7

Configuring the Printer

Use the operation panel to activate the AppleTalk protocol. (The factory default
is active.)

Changing the Printer Name

If the network has several same model printers, the names will be the same.
Printers that have the same name will have their names changed slightly in the
Chooser. For example, three printers named "printer" will appear in the chooser
as "printer0", "printer1" and "printer2".

For more information about changing the printer name, see the “Type 1018 Post-
Script level2 Compatible Kit Operating Instructions Supplement”.

Changing the Zone

It may be necessary to change the zone configuration.

For more information about changing the printer name, see the “Type 1018 Post-
Script level2 Compatible Kit Operating Instructions Supplement”.
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